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Important User Information
Solid state equipment has operational characteristics differing from those of 
electromechanical equipment. Safety Guidelines for the Application, Installation and 
Maintenance of Solid State Controls (Publication SGI-1.1 available from your local 
Rockwell Automation sales office or online at http://www.rockwellautomation.com/
literature) describes some important differences between solid state equipment and 
hard-wired electromechanical devices. Because of this difference, and also because 
of the wide variety of uses for solid state equipment, all persons responsible for 
applying this equipment must satisfy themselves that each intended application of 
this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or 
consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative 
purposes. Because of the many variables and requirements associated with any 
particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of 
information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written 
permission of Rockwell Automation, Inc. is prohibited.

Throughout this manual, when necessary we use notes to make you aware of safety 
considerations.  

Important: Identifies information that is critical for successful application and 
understanding of the product.    

Allen-Bradley, PowerFlex, Pocket DriveExplorer for Pocket PC, DriveExplorer, DriveExecutive, and DPI are either registered 
trademarks or trademarks of Rockwell Automation, Inc.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc.

DeviceNet is a trademark of the Open DeviceNet Vendor Association.

ControlNet is a trademark of ControlNet International Ltd.

Windows, Windows CE, Windows NT, and Microsoft are either registered trademarks or trademarks of Microsoft Corp.

WARNING:  Identifies information about practices or circumstances 
that can cause an explosion in a hazardous environment, which may 
lead to personal injury or death, property damage, or economic loss.

ATTENTION:  Identifies information about practices or circumstances 
that can lead to personal injury or death, property damage, or economic 
loss. Attentions help you:
• identify a hazard
• avoid the hazard
• recognize the consequences

Shock Hazard labels may be located on or inside the equipment (e.g., 
drive or motor) to alert people that dangerous voltage may be present.

Burn Hazard labels may be located on or inside the equipment (e.g., 
drive or motor) to alert people that surfaces may be at dangerous 
temperatures.



Summary of Changes

This is the first release of the 20-WIM-N* Wireless Interface Module 
FRN 1.xxx.
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Preface

About This Manual  

Documentation can be obtained online at 
http://www.rockwellautomation.com/literature.

Topic Page
Related Documentation P-1
Conventions Used in This Manual P-2
Rockwell Automation Support P-3

Related Documentation

For: Refer to: Publication
Pocket DriveExplorer™ for 
Pocket PC

http://www.ab.com/drives/driveexplorer, and 
Pocket DriveExplorer for Pocket PC online help 
(installed with the software)

—

DriveExplorer™ http://www.ab.com/drives/driveexplorer, and 
DriveExplorer online help (installed with the 
software)

—

DriveTools™ SP (includes 
DriveExecutive™)

http://www.ab.com/drives/drivetools, and 
DriveExecutive online help (installed with the software)

—

HIM HIM Quick Reference 20HIM-QR001…
PowerFlex® 70/70EC Drive PowerFlex 70 User Manual 

PowerFlex 70/700 Reference Manual 
20A-UM001…
PFLEX-RM001…

PowerFlex® 700/700VC Drive
PowerFlex® 700 Series B Drive

PowerFlex 700 User Manual
PowerFlex 700 Series B User Manual
PowerFlex 70/700 Reference Manual 

20B-UM001…
20B-UM002…
PFLEX-RM001…

PowerFlex® 700H Drive PowerFlex 700H Installation Instructions
PowerFlex 700H Programming Manual

PFLEX-IN006…
20C-PM001…

PowerFlex® 700S Drive
(Frames 1 through 6)

PowerFlex 700S with Phase I Control User Manual
PowerFlex 700S with Phase II Control User Manual
PowerFlex 700S Reference Manual

20D-UM001…
20D-UM006…
PFLEX-RM002…

PowerFlex® 700S Drive
(Frames 9 through 11)

PowerFlex 700S Installation Instructions
PowerFlex 700S with Phase I Control User Manual
PowerFlex 700S with Phase II Control User Manual
PowerFlex 700S Reference Manual

PFLEX-IN006…
20D-UM001…
20D-UM006…
PFLEX-RM002…

RSLinx™ 
or RSLinx Lite

Getting Results with RSLinx Guide 
Online help (installed with the software)

LINX-GR001…

Bluetooth® wireless 
technology

http://www.Bluetooth.org or http://
www.Bluetooth.com

—

http://www.rockwellautomation.com/literature
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The following conventions are used throughout this manual:

• Parameter names are shown in the format Parameter xx - [*]. The xx 
represents the parameter number. The * represents the parameter 
name. For example Parameter 01 - [DPI Port].

• Menu commands are shown in bold type face and follow the format 
Menu > Command. For example, if you read “Select File > Open,” 
you should click the File menu and then click the Open command.

• The firmware release is displayed as FRN X.xxx. The “FRN” 
signifies Firmware Release Number. The “X” is the major release 
number. The “xxx” is the minor update number.

• Pocket DriveExplorer for Pocket PC (version 1.01), My Bluetooth 
Places software (version 1.4.2), DriveExplorer Lite (version 4.04), 
and DriveExecutive (version 3.01) were used for the screen pictures in 
this manual. Different versions of the software may differ in 
appearance and procedures.

• This manual provides information about the 20-WIM-N* Wireless 
Interface Module (WIM) and using it with PowerFlex 7-Class drives. 
The module can be used with other products that support DPI or 
SCANport.

Conventions Used in This Manual
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Rockwell Automation, Inc. offers support services worldwide, with over 
75 sales/support offices, over 500 authorized distributors, and over 250 
authorized systems integrators located through the United States alone. 
In addition, Rockwell Automation, Inc. representatives are in every 
major country in the world.

Local Product Support

Contact your local Rockwell Automation, Inc. representative for:

• Sales and order support

• Product technical training

• Warranty support

• Support service agreements

Technical Product Assistance

If you need to contact Rockwell Automation, Inc. for technical 
assistance, please review the information in Chapter 4, Troubleshooting, 
first. If you still have problems, call your local Rockwell Automation, 
Inc. representative. 

U.S. Allen-Bradley Drives Technical Support:
E-mail: support@drives.ra.rockwell.com
Tel: (1) 262.512.8176
Fax (1) 262.512.2222
Online: www.ab.com/support/abdrives

UK Customer Support Center:
E-mail: esupport2@ra.rockwell.com
Tel: +44 (0) 870 2411802
Fax: +44 (0) 1908 838804

Germany Customer Service Center:
E-mail: ragermany-csc@ra.rockwell.com
Tel: +49 (0) 2104 960-630
Fax: +49 (0) 2104 960-501

Rockwell Automation Support



P-4 About This Manual
Notes:



Chapter 1

Getting Started

The 20-WIM-N* Wireless Interface Module (WIM) provides a wireless 
communications interface between a Pocket PC, laptop computer or 
desktop computer equipped with Bluetooth wireless technology and any 
Allen-Bradley product supporting DPI. The WIM uses the full-duplex 
DF1 protocol.

Important: The WIM also supports legacy Allen-Bradley AC drives 
that use the SCANport protocol.  

Figure 1.1   Components of the WIM 

Topic Page
Components 1-1 
Features 1-2
DPI Compatible Products 1-2
SCANport Compatible Products 1-2
Required Equipment 1-3
Safety Precautions 1-4
Quick Start 1-5
Modes of Operation 1-6

Components 

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation

➊

(NEMA 1 WIM shown)

 

Item Part Description

➊ Status 
Indicator

LED that indicates WIM 
operation, when data is being 
received from the Bluetooth 
wireless technology enabled 
Pocket PC or computer, and 
when data is being sent to 
the Pocket PC or computer. 
Refer to Modes of Operation 
in this chapter, and 
Chapter 4, Troubleshooting 
for more information.
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Features of the WIM include the following:

• A status indicator (LED) that reports the operating status of the 
module.

• Connectivity to products implementing DPI, such as PowerFlex 
7-Class drives and peripherals, and products implementing 
SCANport, such as legacy Allen-Bradley drives. When used with a 
product, the WIM will autobaud to the DPI or SCANport data rate 
that is used by the product.

• The WIM receives power from the drive. An outside power source is 
not needed.

• The following tools can be used to configure the WIM:

– Pocket DriveExplorer for Pocket PC (version 1.01 or higher)
– DriveExplorer (version 4.04 or higher)
– DriveExecutive (version 3.01 or higher)
– PowerFlex 7-Class HIM

DPI is a second generation peripheral communication interface. The 
WIM can be used with Allen-Bradley PowerFlex 7-Class drives and 
other products that support DPI. At the time of publication, compatible 
products include all the following types of:  

The WIM is also compatible with drives and other products that support 
SCANport. At the time of publication, compatible products include:  

Features 

DPI Compatible Products 

• PowerFlex 70 drives • PowerFlex 700S drives
• PowerFlex 700 drives • PowerFlex 7000 drives
• PowerFlex 700H drives • SMC-Flex

SCANport Compatible Products 

• 1305 drives • 1336 REGEN drives • 2364F RGU
• 1336 PLUS drives • 1336 SPIDER drives • SMC Dialog Plus
• 1336 PLUS II drives • 1394 Servo drives • SMP-3
• 1336 IMPACT drives • 1397 drives
• 1336 FORCE drives • 1557 drives
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Equipment Shipped with the WIM

When you unpack the WIM, verify that the package includes:  

User-Supplied Equipment

To configure the WIM, you must use one of the following:  

Required Equipment

❑ One Wireless Interface Module

❑ This manual

❑ Pocket DriveExplorer for Pocket PC software (version 1.01 or 
higher) running on a Pocket PC equipped with Bluetooth wireless 
technology

❑ DriveExplorer software (version 4.04 or higher) running on a laptop 
or desktop computer equipped with Bluetooth wireless technology

❑ DriveExecutive stand-alone software (version 3.01 or higher) or 
bundled with the DriveTools SP suite (version 1.01 or higher) 
running on a laptop or desktop computer equipped with Bluetooth 
wireless technology

❑ PowerFlex 7-Class HIM (20-HIM-*)
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Please read the following safety precautions carefully.  

Safety Precautions 

!
ATTENTION:  Risk of injury or death exists from machine motion 
when using wireless communications and software to Start/Stop/Jog, 
configure or otherwise communicate with a drive.

Using the control bar feature in Pocket DriveExplorer for Pocket PC, 
DriveExplorer or DriveExecutive with wireless communications may 
present safety hazards due to potential loss of the wireless connection. 
For example, if the wireless connection is interrupted after a start or jog 
command is initiated from the control bar, the drive cannot be stopped 
using the control bar until the wireless connection is restored. For this 
reason, it is required to always use an additional hard-wired stop circuit 
to disable the drive.

!
ATTENTION:  Risk of injury or equipment damage exists. Only 
personnel familiar with drive and power products and the associated 
machinery should plan or implement the installation, start-up, 
configuration, and subsequent maintenance of the product using a 
WIM. Failure to comply may result in injury and/or equipment damage.

!
ATTENTION:  Risk of injury or equipment damage exists. 
Parameter 02 - [Comm Flt Action] lets you determine the action of 
the WIM and connected drive if wireless communications are 
disrupted. By default, this parameter faults the drive. You can set this 
parameter so that the drive continues to run. Precautions should be 
taken to ensure that the setting of this parameter does not create a risk 
of injury or equipment damage. When commissioning the drive, verify 
that your system responds correctly to various situations (for example, a 
communication disruption or a faulted controller).
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This section is designed to help experienced users quickly start using the 
WIM. If you are unsure how to complete a step, refer to the referenced 
chapter.  

Figure 1.2   NEMA 1 WIM (20-WIM-N1) Installed in a Drive 

Figure 1.3   NEMA 1 WIM (20-WIM-N1) Installed in a HIM Bezel (20-HIM-B1)  

Quick Start 

Step Action Refer to . . .
1 Review the safety precautions for the WIM. Throughout this 

manual
2 Install the WIM.

For the NEMA 1 WIM (20-WIM-N1), remove the HIM from the 
drive cradle and replace it with the WIM. To install the WIM in a 
remote-mounted HIM bezel (20-HIM-B1), first install the bezel 
(see Publication 20HIM-IN001...). Make sure the HIM bezel is 
connected to the drive port using the supplied 1203-C30 cable, 
and then place the WIM in the bezel cradle.

For the NEMA 4 WIM (20-WIM-N4S), see Chapter 2, Installing 
the NEMA 4 WIM (20-WIM-N4S) for installation instructions.

Chapter 2, 
Installing the 
WIM

3 Configure the WIM parameters.

The WIM is provided ready for use. It is only necessary to 
configure the WIM if you want to change the default setting 
(0 = Fault) for Parameter 02 - [Comm Flt Action], or enable the 
WIM security mode using Parameter 03 - [Security Mode] and 
Parameter 04 - [Security PIN].

Chapter 3, 
Configuring the 
WIM

Pocket PC, 
Laptop or Desktop 

Computer
PowerFlex 70/700 Drive 

with Installed WIM

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation

PowerFlex 70/700 Drives 
(with 20-COMM-* Adapter)

Network (DeviceNet, ControlNet, etc.) HIM Bezel with 
Installed WIM

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation

Pocket PC, 
Laptop or Desktop 

Computer
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The WIM reports its operating status using a tri-color status indicator 
(Figure 1.4).

Figure 1.4   Status Indications of the WIM  

The following table describes the status indications under normal 
operation:  

If any other conditions occur, refer to Chapter 4, Troubleshooting.

Modes of Operation

Item Status Indication Description

➊ Solid Blue The WIM is receiving data from the Bluetooth wireless 
technology enabled Pocket PC or computer, or transmitting 
data to the Pocket PC or computer.

Flickering Blue The WIM is receiving a ping from the Bluetooth wireless 
technology enabled Pocket PC or computer as WIM data is 
transmitted back to the Pocket PC or computer.

Flashing Green The WIM is operating, but has not established wireless 
communication with the Bluetooth wireless technology 
enabled Pocket PC or computer.

Flashing Red The WIM is attempting to establish communications with the 
drive.  This will occur momentarily during the power-up 
sequence and is normal.

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation

➊

(NEMA 1 WIM shown)



Chapter 2

Installing the WIM

This chapter provides instructions for installing and removing the WIM.  

The WIM is offered in two styles: a NEMA 1 module (20-WIM-N1) and 
a NEMA 4 module (20-WIM-N4S). Each style is installed differently.  

The NEMA 1 WIM (20-WIM-N1) typically replaces the HIM, and is 
normally installed in the HIM (Human Interface Module) cradle on the 
front of the drive. When a HIM is still required and occupies the cradle, 
the 20-WIM-N1 module can be installed in a HIM bezel (20-HIM-B1) 
mounted in a remote location.

Installing the WIM in a Drive

1. If a HIM is installed on the drive, remove the HIM, and replace it 
with the WIM (Figure 2.1).

Important: If the drive is mounted in an enclosure, the NEMA 1 
WIM must be installed in a HIM bezel or you must use 
a NEMA 4 WIM. Using the NEMA 1 WIM installed at 
the drive (DPI Port 1) in the enclosure will decrease 
wireless signal transfer, resulting in possible 
intermittent disconnection of the drive.

2. The status LED on the WIM momentarily flashes red on powerup 
and then flashes green to indicate it is ready to establish wireless 
communication with the Pocket PC or computer.

Topic Page
Installing the NEMA 1 WIM (20-WIM-N1) 2-1
Installing the NEMA 4 WIM (20-WIM-N4S) 2-3
Removing the NEMA 1 WIM (20-WIM-N1) 2-5

Installing the NEMA 1 WIM (20-WIM-N1) 
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3. Establish wireless communication between the WIM and the Pocket 
PC or computer. For details, refer to Chapter 3, Using Pocket 
DriveExplorer for Pocket PC, Using DriveExplorer/DriveExplorer 
Lite, or Using DriveExecutive. When communication is achieved, the 
WIM status LED will turn solid blue.

Figure 2.1   Installing the WIM in a Drive  

Installing the WIM in a HIM Bezel (20-HIM-B1)

1. If the HIM bezel is not mounted, refer to Publication 
20HIM-IN002... for bezel installation instructions.

2. Route the bezel cable to the drive. Connect the bezel cable to the DPI 
port on the bottom of the drive.

3. Install the WIM into the HIM bezel cradle (Figure 2.2).

Figure 2.2   Installing the WIM in a HIM Bezel  

20-WIM-N1 
(Wireless Interface Module)

HIM 
(Human Interface Module)

PowerFlex 70/700 Drive

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation

20-WIM-N1  
(Wireless Interface Module)

20-HIM-B1 
Bezel

PowerFlex 70/700 Drive 
with Installed HIM

3 m (9.8 ft.) 
Bezel Cable*

*Distance can be increased up to 100 m (328 ft.) using 
1202-H* Extension cable(s) or 1202-CBL-KIT-100M cable. 
A cable distance greater than 30 m is not CE compliant.

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation
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4. The status LED on the WIM momentarily flashes red on powerup 
and then flashes green to indicate it is ready to establish wireless 
communication with the Pocket PC or computer.

5. Establish wireless communication between the WIM and the Pocket 
PC or computer. For details, refer to Chapter 3, Using Pocket 
DriveExplorer for Pocket PC, Using DriveExplorer/DriveExplorer 
Lite, or Using DriveExecutive. When communication is achieved, the 
WIM status LED will turn solid blue.

The NEMA 4 WIM (20-WIM-N4S) is designed for remote installation. 
Refer to Figure 2.3 for overall WIM dimensions. Choose an appropriate 
location to mount the NEMA 4 WIM. The distance between the WIM 
and drive can be increased up to 100 m (328 ft.) using 1202-H* 
extension cable(s) or 1202-CBL-KIT-100M cable. A cable distance 
greater than 30 m is not CE compliant.

Figure 2.3   NEMA 4 WIM Dimensions  

1. Drill the required hole pattern in the panel. See Figure 2.4 for 
dimensions.

Installing the NEMA 4 WIM (20-WIM-N4S) 

93,0
(3.66)

25,0
(0.98)

3.0 m

mm
(in.)

180,0
(7.08)

1202-H03 = 0.3 m
1202-H10 = 1.0 m
1202-H30 = 3.0 m

Extension Cable 
(supplied separately)

or 1202-CBL-KIT-100M

Contains FCC ID: SNT-2XWIMNX

     IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:

1) this device may not cause harmful interference, and

2) this device must accept any interference received,

including interference that may cause undesired operation
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Figure 2.4   Hole Pattern for Mounting NEMA 4 WIM 

2. Peel the protective film from the gasketed surface on the back of the 
WIM (Figure 2.5).

3. Insert the supplied 3 m (9.8 ft.) WIM cable into the mating socket on 
the back of the WIM.

4. Install the supplied O-ring into the cable routing hole on the panel to 
protect the cable. Then route the WIM cable through the cable 
routing hole on the panel.

5. Align the six threaded studs of the WIM with the panel clearance 
holes, and place the WIM against the panel.

6. Tighten the nuts onto the six threaded studs of the WIM extending 
behind the panel. Recommended torque is 0.68 N-m (6.0 lb.-in.).

7. Route the WIM cable to the drive. Connect the WIM cable to the DPI 
port on the bottom of the drive.

8. Apply power to the drive. The status LED on the WIM momentarily 
flashes red on powerup and then flashes green to indicate it is ready 
to establish wireless communication with the Pocket PC or computer.

67,0 
(2.63)

60,0 
(2.36)

77,0 
(3.03)

77,0 
(3.03)

53,5 
(2.11)

∅19,1 
(0.75)

∅4,8 
(0.19)
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9. Establish wireless communication between the WIM and the Pocket 
PC or computer. For details, refer to Chapter 3, Using Pocket 
DriveExplorer for Pocket PC, Using DriveExplorer/DriveExplorer 
Lite, or Using DriveExecutive. When communication is achieved, the 
WIM status LED will turn solid blue.

Figure 2.5   Mounting NEMA 4 WIM onto Panel  

The drive can remain powered when removing a WIM.

Remove the WIM from the drive HIM cradle or the remote-mounted 
HIM bezel.

➌

➋

➍

➎

➏
0.68 N-m

(6.0 lb.-in.)

Removing the NEMA 1 WIM (20-WIM-N1)

!
ATTENTION:  Risk of injury or equipment damage exists. If the HIM 
bezel cable (for a bezel-mounted WIM) is disconnected from Port 2 on 
the bottom of the drive, the drive may fault. Determine how the drive 
will respond before disconnecting the cable.
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Notes:



Chapter 3

Configuring the WIM

This chapter provides information about configuring the WIM.  

 

For a list of parameters, refer to Appendix B, WIM Parameters. For 
definitions of terms in this chapter, refer to the Glossary.

The WIM stores parameters and other information in its own 
Non-Volatile Storage (NVS). You must, therefore, access the WIM to 
view and edit its parameters. The following table lists tools that you can 
use to access the WIM and edit its parameters.  

Topic Page
Configuration Tools 3-1
Using Pocket DriveExplorer for Pocket PC 3-2
Using DriveExplorer/DriveExplorer Lite 3-10
Using DriveExecutive 3-15
Setting the Fault Action 3-22
Enabling and Setting the Security Mode 3-23
Resetting the WIM 3-24

TIP:  The WIM is provided ready for use. It is only necessary to 
configure the WIM if you want to change the default setting (0 = Fault) 
for Parameter 02 - [Comm Flt Action], or enable the security mode 
using Parameter 03 - [Security Mode] and Parameter 04 - [Security 
PIN].

Configuration Tools 

Device Type Tool Refer to…
Pocket PC Pocket DriveExplorer for Pocket PC 

(version 1.01 or higher)
page 3-2

Laptop or Desktop 
Computer

DriveExplorer software 
(version 4.04 or higher)

page 3-10

DriveExecutive software 
(version 3.01 or higher)

page 3-15

PowerFlex HIM —
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With Pocket DriveExplorer for Pocket PC software running on a Pocket 
PC equipped with Bluetooth wireless technology, you can edit parameters 
in the WIM, connected drive, and any of the attached peripherals.

If you are unsure how to use Pocket DriveExplorer for Pocket PC, refer 
to the online help (select Help > Help Topics).  

Establishing Wireless Communication Between the WIM and 
Pocket PC

1. Launch Pocket DriveExplorer for Pocket PC from the Today Screen 
to create a new connection using the Connection Manager 
(Figure 3.1).

Figure 3.1   Connection Manager Screen  

Using Pocket DriveExplorer for Pocket PC

!
ATTENTION:  Risk of injury or death exists from machine motion 
when using wireless communications and software to Start/Stop/Jog, 
configure or otherwise communicate with a drive.

Using the control bar feature in Pocket DriveExplorer for Pocket PC 
(version 2.01 or higher) with wireless communications may present 
safety hazards due to potential loss of the wireless connection. For 
example, if the wireless connection is interrupted after a start or jog 
command is initiated from the control bar, the drive cannot be stopped 
using the control bar until the wireless connection is restored. For this 
reason, it is required to always use an additional hard-wired stop circuit 
to disable the drive.
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2. Select Connect > New from the menu list. The New Connection 
Wizard appears (Figure 3.2).

Figure 3.2   New Connection Wizard Screen  

3. Select the “Bluetooth” radio button and click Next ->. The “Where is 
your destination?” screen appears (Figure 3.3).

Figure 3.3   “Where is your destination?” Screen 
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4. Select one of the radio button choices:

• Remote - routed over a network: Choose “Remote” if you want 
to connect to a local drive using the 20-WIM and then route 
through it to a DeviceNet (via 20- COMM-D adapter), ControlNet 
(via 20-COMM-C adapter) or Ethernet (via 20-COMM-E adapter) 
remote device. If you select “Remote,” go to Step 10 on Page 3-7. 
Step 10 must be performed before proceeding with Step 5 on 
Page 3-4.

• Local - point-to-point: Choose “Local” if you want to connect 
only to a local drive using the 20-WIM. Selecting “Local” and 
clicking Next -> displays the “Local Connection” screen 
(Figure 3.4) which requests you to name the connection for later 
reuse.

Figure 3.4   Local Connection Screen 

5. Enter a name and click Next ->. The “Connection Summary” screen 
appears (Figure 3.5).

Figure 3.5   Connection Summary Screen 
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6. You can save the connection information and connect immediately, 
or save the connection for connecting later. Note that the top of this 
screen contains temporary diagnostic information.

After clicking a choice, the “Location for saved connection” screen 
(Figure 3.6) appears, enabling you to navigate to a convenient 
location on the Pocket PC to store connections.

Figure 3.6   “Location for saved connection” Screen 

7. Click OK to save the connection file and begin the connection 
process. The “Searching for Bluetooth Connections” screen appears 
(Figure 3.7), asking you to select a detected Bluetooth device.

Figure 3.7   Searching for Bluetooth Connections Screen 
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8. Select the Bluetooth device from this screen and click OK. This 
screen only appears the first time you connect to this Bluetooth 
device.  Its address is saved to the connection file. The next time you 
open the connection, if this same device is within range, Pocket 
DriveExplorer for Pocket PC will immediately connect.

The connection process then begins (Figure 3.8).

Figure 3.8   Opening Connection Screen 

9. The status bar will update and then when connection is complete, the 
Status Monitor application will launch and show the “Status 
Monitor” screen (Figure 3.9).

Figure 3.9   Status Monitor Screen 

You can then select other devices from the Port menu, or other 
functions from the Tasks menu.
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10. If you will be routing to a remote networked device, this additional 
step will need to be done using the New Connection Wizard.  This 
requires that you are able to connect to the Bluetooth card/module 
(cannot be done offline) because Pocket DriveExplorer for Pocket 
PC must interrogate the device and determine what kinds of network 
adapters are present.

Figure 3.10   “Where is your destination?” Screen 

A. After selecting “Remote,” click the Next -> button. Pocket 
DriveExplorer for Pocket PC will connect to the Bluetooth 
device (Figure 3.11).

Figure 3.11   Bluetooth Browser Screen 

B. If the device has more than one network card, you will be 
prompted to select one (Figure 3.12), otherwise Pocket 
DriveExplorer for Pocket PC will present the next screen based 
on single network card detected.
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Figure 3.12   “More than one network card…” Screen 

C. You will need to select the address of the remote device on its 
network. See Figure 3.13 for DeviceNet and ControlNet, or 
Figure 3.14 for EtherNet/IP.

Figure 3.13   DeviceNet and ControlNet Remote Configuration Address 
Screen 
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Figure 3.14   EtherNet/IP Remote Configuration Address Screen

D. Click the Next -> button and return back to Step 5 on Page 3-4 to 
continue.
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With DriveExplorer software running on a computer equipped with 
Bluetooth wireless technology, you can edit parameters in the WIM, 
connected drive, and any of the attached peripherals. DriveExplorer Lite, 
a free, limited-feature version of DriveExplorer, can be downloaded 
from http://www.ab.com/drives/driveexplorer.

If you are unsure how to use DriveExplorer or DriveExplorer Lite, refer 
to the online help (select Help > Help Topics).  

Establishing Wireless Communication Between the WIM and 
Computer

Bluetooth wireless technology enabled cards/modules installed in a 
computer are typically provided with a software program to establish 
communication with other wireless devices. The following example 
procedure describes how to establish communication using the software 
program “My Bluetooth Places” (version 1.4.2), which was included 
with a specific brand Bluetooth wireless technology module. Different 
versions of this software and different programs may differ in 
appearance and procedures.

1. Launch the “My Bluetooth Places” program. The program window 
will appear (Figure 3.15).

Using DriveExplorer/DriveExplorer Lite

!
ATTENTION:  Risk of injury or death exists from machine motion 
when using wireless communications and software to Start/Stop/Jog, 
configure or otherwise communicate with a drive.

Using the control bar feature in DriveExplorer (version 2.01 or higher) 
with wireless communications may present safety hazards due to 
potential loss of the wireless connection. For example, if the wireless 
connection is interrupted after a start or jog command is initiated from 
the control bar, the drive cannot be stopped using the control bar until 
the wireless connection is restored. For this reason, it is required to 
always use an additional hard-wired stop circuit to disable the drive.
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Figure 3.15   My Bluetooth Places Program Window  

2. In the “My Bluetooth Places” program window, double-click the 
“Find Bluetooth Devices” icon, which starts a search to find the 
device to which you want to connect. The “Entire Bluetooth 
Neighborhood” window appears (Figure 3.16), displaying icons of 
all Bluetooth wireless technology enabled devices detected by the 
computer card or module that are within its reception range.

Important: Wait for the search to complete before proceeding.

Figure 3.16   Entire Bluetooth Neighborhood Window 
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3. In the “Entire Bluetooth Neighborhood” window, double-click on the 
device icon to which you want to establish wireless communication 
(for this example, the “PowerFlex 70” icon). The “PowerFlex 70” 
connection window will appear (Figure 3.17).

Figure 3.17   PowerFlex 70 Connection Window 

4. In the “PowerFlex 70” connection window, double-click the “COM1 
on PowerFlex…” icon to initiate the wireless communication 
connection. A pop-up dialog box appears (Figure 3.18), indicating 
the specific COM port to use for the connection (COM8 for this 
example). Click OK.

Important: Always note the COM port shown in the dialog box 
because this same specific port must be selected in the 
DriveExplorer/DriveExplorer Lite Configure 
Communication window (Step 6).

Figure 3.18   COM8 Dialog Box 
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The “PowerFlex 70” connection window re-appears (Figure 3.19), 
but this time with the “COM1 on PowerFlex…” icon lit up in green, 
indicating that a wireless communication connection now exists.

Figure 3.19   PowerFlex 70 Connection Window with Lit Green Icon 

5. Launch DriveExplorer or DriveExplorer Lite to access parameters in 
the WIM, connected drive, and any of the attached peripherals. Then 
select Explore > Configure Communication. The Configure 
Communication screen will appear (Figure 3.20).

Figure 3.20   DriveExplorer/DriveExplorer Lite Configure Communication 
Screen 

6. Select the same COM port established by the Bluetooth wireless 
technology enabled computer (noted in Step 4). For this example, 
COM8 is used. Then click OK.
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7. In the DriveExplorer or DriveExplorer Lite window, select Explore 
> Connect > Serial Point-to-Point to display the DriveExplorer 
menu tree window. In the left pane, click the + signs to expand the 
tree. For this example, click on “20-WIM-Nx Wireless DF1” to 
display the WIM parameters in the right pane (Figure 3.21). 
Double-click a parameter to edit it.

Figure 3.21   DriveExplorer/DriveExplorer Lite Menu Tree Window 
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With DriveExecutive software running on a computer equipped with 
Bluetooth wireless technology, you can edit parameters in the WIM, 
connected drive, and any of the attached peripherals.

If you are unsure how to use DriveExecutive, refer to the online help 
(select Help > Help Topics).  

Establishing Wireless Communication Between the WIM and 
Computer

Bluetooth wireless technology enabled cards/modules installed in a 
computer are typically provided with a software program to establish 
communication with other wireless devices. The following example 
procedure describes how to establish communication using the software 
program “My Bluetooth Places” (version 1.4.2), which was included 
with a specific brand Bluetooth wireless technology module. Different 
versions of this software and different programs may differ in 
appearance and procedures.

1. Launch the “My Bluetooth Places” program. The program window 
will appear (Figure 3.22).

Using DriveExecutive 

!
ATTENTION:  Risk of injury or death exists from machine motion 
when using wireless communications and software to Start/Stop/Jog, 
configure or otherwise communicate with a drive.

Using the control bar feature in DriveExecutive (version 4.01 or higher) 
with wireless communications may present safety hazards due to 
potential loss of the wireless connection. For example, if the wireless 
connection is interrupted after a start or jog command is initiated from 
the control bar, the drive cannot be stopped using the control bar until 
the wireless connection is restored. For this reason, it is required to 
always use an additional hard-wired stop circuit to disable the drive.
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Figure 3.22   My Bluetooth Places Program Window  

2. In the “My Bluetooth Places” program window, double-click the 
“Find Bluetooth Devices” icon, which starts a search to find the 
device to which you want to connect. The “Entire Bluetooth 
Neighborhood” window appears (Figure 3.23), displaying icons of 
all Bluetooth wireless technology enabled devices detected by the 
computer card or module that are within its reception range.

Important: Wait for the search to complete before proceeding.

Figure 3.23   Entire Bluetooth Neighborhood Window 
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3. In the “Entire Bluetooth Neighborhood” window, double-click on the 
device icon to which you want to establish wireless communication 
(for this example, the “PowerFlex 70” icon). The “PowerFlex 70” 
connection window will appear (Figure 3.24).

Figure 3.24   PowerFlex 70 Connection Window 

4. In the “PowerFlex 70”connection window, double-click the “COM1 
on PowerFlex…” icon to initiate the wireless communication 
connection. A pop-up dialog box appears (Figure 3.25), indicating 
the specific COM port to use for the connection (COM8 for this 
example). Click OK.

Important: Always note the COM port shown in the dialog box 
because this same specific port must be selected in the 
RSLinx Configure RS-232 DF1 Devices window 
(Step 6).

Figure 3.25   COM8 Dialog Box 
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The “PowerFlex 70” connection window re-appears (Figure 3.26), 
but this time with the “COM1 on PowerFlex…” icon lit up in green, 
indicating that a wireless communication connection now exists.

Figure 3.26   PowerFlex 70 Connection Window with Lit Green Icon 

5. Launch RSLinx to create a driver to represent the connection on 
COM8 (communication port assigned in Step 4 on Page 3-17).

6. Select Communications > Configure Drivers… to display the 
Configure Drivers screen. From the Available Driver Types pulldown 
list, select “RS-232 DF1 devices” as shown in Figure 3.27.

Figure 3.27   Configure Drivers Screen 
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7. After the driver is selected, click “Add New….” The Add New 
RSLinx Driver screen will appear. Create a name for the new driver 
or use the default name, and click OK.

8. The Configure RS-232 DF1 Devices window appears (Figure 3.28).

Figure 3.28   Configure RS-232 DF1 Devices Window  

Use the following settings:  

Then click OK.

9. The Configure Drivers window will re-appear (Figure 3.29). Verify 
that the status of the newly created driver is “Running.” Then click 
Close.

Configuration Field Setting
Comm Port Select the same COM port established by the Bluetooth 

wireless technology enabled computer (noted in Step 4). For 
this example, COM8 is used.

Device 1770-KF2/1785-KE/SCANport
Baud Rate Any setting
Station Number 00
Parity None
Error Checking Important: Change to “CRC.”
Stop Bits 1
Protocol Full Duplex
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Figure 3.29   Configure Drivers Window  

10. Select Communications > RSWho to display the browse window. 
Then expand the menu tree in the left pane for the drive name 
assigned in Step 7 to verify that the driver is communicating with the 
device. The screen should look similar to Figure 3.30.

Figure 3.30   RSLinx Browse Window  

11. Launch DriveExecutive to access parameters in the WIM, connected 
drive, and any of the attached peripherals.

12. In the DriveExecutive window, select Drive > Connect to Drive… 
to display the Connect to Drive menu tree window. Then expand the 
menu tree in the left pane for the drive name assigned in Step 7. The 
screen should look similar to Figure 3.31. Then click OK. 
DriveExecutive will begin updating drive information such as 
parameter names, diagnostics, etc. and store them in a 
DriveExecutive directory established for this purpose.
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Figure 3.31   Connect to Drive Window  

13. In the left pane of the DriveExecutive menu tree window, click the + 
signs to expand the tree. For this example, click on “20-WIM-Nx 
Linear List” to display the WIM parameters in the right pane 
(Figure 3.32). To edit a parameter, double-click it or use the Value 
column pulldown menu.

Figure 3.32   DriveExecutive Menu Tree Window  
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By default, when communications are disrupted (for example, loss of 
wireless communication), the WIM and connected drive respond by 
faulting. You can configure a different response to communication 
disruptions using Parameter 02 - [Comm Flt Action].

To change the fault action
• Set the value of Parameter 02 - [Comm Flt Action] to the desired 

response:  

Changes to this parameter take effect immediately. A reset is not 
required.

Setting the Fault Action

!
ATTENTION:  Risk of injury or equipment damage exists. 
Parameter 02 - [Comm Flt Action] lets you determine the action of 
the WIM and connected drive if communications are disrupted. By 
default, this parameter faults the drive. You can set this parameter so 
that the drive continues to run. Precautions should be taken to ensure 
that the setting of this parameter does not create a risk of injury or 
equipment damage. When commissioning the drive, verify that your 
system responds correctly to various situations (for example, disruption 
of wireless communication).

Value Action Description
0 Fault The drive will fault.
1 Stop The drive will stop and not fault (DPI host products only).
2 Zero Data The drive is sent 0 for output data after a communications 

disruption. This does not command a stop.
3 Hold Last The drive continues in its present state after a 

communications disruption.
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The WIM has a security mode to prevent access to its configuration and 
the connected drive. You can enable the security mode using Parameter 
03 - [Security Mode], and set a desired PIN number using Parameter 
04 - [Security PIN].

To enable the WIM security mode

1. Set Parameter 03 - [Security Mode] to “PIN Required.”  

2. Reset the WIM. See Resetting the WIM section in this chapter.

To set a PIN number

1. Set Parameter 04 - [Security PIN] to a desired number (0-9999). 
The default is “0.”

For your convenience, please write down your assigned PIN number 
and store it in a safe place:

PIN Number = ___ ___ ___ ___

2. Reset the WIM. See Resetting the WIM section in this chapter.

To reset a PIN number when misplaced or forgotten

If you misplaced or forgot the assigned PIN number, you will not be able 
to connect to the WIM using drive software.

• DPI Drive – To reset the PIN number, you will first need to use a 
different DPI peripheral (for example, 20-HIM) to access the WIM 
Parameter 03 - [Security Mode] and set it to “0.” Then access 
Parameter 04 - [Security PIN] to view the previous PIN number.

• SCANport Drive – Since a SCANport drive does not support 
peripheral routing, you cannot access the WIM parameters using a 
legacy HIM (for example, 1201-H*). To reset the PIN number, you 
will need to disconnect the WIM and reconnect it to a DPI drive. 
This enables access to the WIM parameters to reset or disable the 
PIN number. For additional assistance, contact Drives Technical 
Support at the numbers listed on Page P-3.

Enabling and Setting the Security Mode

Value Description
0 PIN Not Required (Default)
1 PIN Required
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Changes to some WIM parameters require that you reset the WIM before 
the new settings take effect. You can reset the WIM by cycling power to 
the drive or by using Parameter 05 - [Reset Module].

• Set Parameter 05 - [Reset Module] to Reset Module.  

After you enter 1 = Reset Module, the WIM will be immediately reset. 
When you enter 2 = Set Defaults, the WIM will set all WIM parameters 
to their factory-default settings. After performing a Set Defaults, enter 
1 = Reset Module so that the new values take effect. The value of this 
parameter will be restored to 0 = Ready after performing the reset or 
setting the defaults.

Resetting the WIM

Value Description
0 Ready (Default)
1 Reset Module
2 Set Defaults
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Troubleshooting 

This chapter provides information to troubleshoot the WIM.  

The WIM reports its operating status using a status indicator 
(Figure 4.1).

Figure 4.1   Status Indications of the WIM  

Status Indications  

Topic Page
Understanding the Status Indicator 4-1
Viewing WIM Diagnostic Items 4-3
Viewing and Clearing Events 4-4
Viewing and Clearing DF1 Communication Statistics 4-5

Understanding the Status Indicator 

Status Cause Corrective Action
Off WIM is not powered. • Securely place WIM in cradle or bezel, 

or securely connect bezel or WIM cable 
to the drive.

• Apply power to the drive.

Contains FCC ID: SNT-2XWIMNX
   IC: 5450A-2XWIMNX 

This device complies with Part 15 of the FCC rules.
Operation is subject to the following two conditions:
1) this device may not cause harmful interference, and
2) this device must accept any interference received,
including interference that may cause undesired operation

➊

(NEMA 1 WIM shown)
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Flashing 
Green

WIM is communicating with 
drive, but not transmitting or 
receiving wireless signals.

Establish wireless communication with the 
Bluetooth wireless technology enabled 
Pocket PC or computer. For details, refer to 
one of these sections in Chapter 3:

• Using Pocket DriveExplorer for Pocket 
PC

• Using DriveExplorer/DriveExplorer Lite

• Using DriveExecutive.
Flashing 
Red/Green

WIM is in boot mode, or WIM 
may have a corrupted flash 
file.

• No action required. Normal behavior 
when powering up.

• Reflash WIM firmware. If issue persists, 
return WIM to factory for repair/
replacement.

Solid Blue WIM is communicating with 
drive.

No action required.

Flickering 
Blue

WIM is communicating with 
drive, and is being pinged by 
the Pocket PC or computer.

No action required.

Solid Red Communication error. • Power cycle the drive.

• Check cables and their connections.
Flashing 
Red 
(momentary)

WIM is in startup sequence 
and is initializing 
communication with the 
drive.

No action required.

Flashing 
Red 
(continuous)

WIM is not communicating 
with drive.

• Power cycle the drive.

• Check cables and their connections.

Status Cause Corrective Action
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WIM Diagnostic Items are viewable with the following tools:

• For Pocket PCs, use Pocket DriveExplorer for Pocket PC software 
(version 1.01 or higher).

• For laptop or desktop computers, use DriveExplorer software 
(version 4.04 or higher), DriveExecutive software (version 3.01 or 
higher).

• An LCD PowerFlex 7-Class HIM.

If you encounter unexpected communications problems, diagnostic 
items can help you or Rockwell Automation personnel troubleshoot the 
problem.  

Viewing WIM Diagnostic Items

No. Name Description
1 Common Logic 

Cmd
Current value of the Common Logic Command being transmitted 
to the drive by the WIM.

2 Prod Logic Cmd Current value of the Product Specific Logic Command being 
transmitted to the drive by the WIM.

3 Reference Current value of the Product Specific Reference being 
transmitted to the drive by the WIM. 

4 Common Logic 
Sts

Current value of the Common Logic Status being received from 
the drive by the WIM.

5 Prod Logic Sts Current value of the Product Specific Logic Status being received 
from the drive by the WIM.

6 Feedback Current value of the Product Specific Feedback being received 
from the drive by the WIM. 

7 DPI Rx Err Cntr Current value of the DPI CAN Receive Error Counter register.
8 DPI Rx Err Max Maximum value of the DPI CAN Receive Error Counter register.
9 DPI Tx Err Cntr Current value of the DPI CAN Transmit Error Counter register.
10 DPI Tx Err Max Maximum value of the DPI CAN Transmit Error Counter register.
11 Field Flash Cntr Current value of the Field Flash Counter.
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The WIM maintains an event queue that reports the history of its actions. 
You can view the event queue with the following tools:

• For Pocket PCs, use Pocket DriveExplorer for Pocket PC software 
(version 1.01 or higher).

• For laptop or desktop computers, use DriveExplorer software 
(version 4.04 or higher), DriveExecutive software (version 3.01 or 
higher).

• An LCD PowerFlex 7-Class HIM.

To view the event queue

1. Access the event queue using a configuration tool.

2. Scroll through events in the event queue.

Events

Many events in the Event queue occur under normal operation. If you 
encounter unexpected communications problems, the events may help 
you or Allen-Bradley personnel troubleshoot the problem. The following 
events may appear in the event queue:  

Viewing and Clearing Events 

Event Description
Control Disabled The WIM has sent a “Soft Control Disable” command to the DPI 

drive.
Control Enabled The WIM has sent a “Soft Control Enable” command to the DPI 

drive.
DPI Bus Off Flt A bus-off condition was detected on DPI. This event may be caused 

by loose or broken cables or by noise.
DPI Fault Clear The DPI drive has issued a fault clear message.
DPI Fault Msg The drive entered a faulted state.
Dup. Port Flt Another peripheral with the same port number is already in use.
EEPROM Sum Flt The EEPROM in the WIM is corrupt.
Host Sent Reset The DPI drive issued this event because it was reset.
Message Timeout The DPI drive did not respond to a message request. Verify the 

cables are correct.
No Event Empty event queue entry.
Normal Startup WIM initially powered up or was reset.
Online @ 125kbps The WIM and DPI drive are communicating at 125kbps.
Online @ 500kbps The WIM and DPI drive are communicating at 500kbps.
PCCC I/O Time Flt The WIM has not received a PCCC Control message for longer than 

the specified PCCC Control Time-out.
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To clear the event queue

1. Access the event queue using a configuration tool.

2. Set the value of 1 > Clr Event Queue to Enable, and then press 
Enter to clear the event queue.

 

If you encounter unexpected communications problems or are creating 
an application that uses DF1 data, you can view the communications 
statistics in the WIM. Parameter 10 - [DF1 Packets Sent] and 
Parameter 11 - [DF1 Packets Rcvd] store this data.

To view and clear DF1 data, you must access the main menu in the WIM 
firmware.

To view DF1 data

1. Access the parameters in the WIM using a configuration tool.

2. Scroll through the DF1 Parameters 10 and 11, which contain DF1 
data. For a description of each parameter, refer to Appendix B, WIM 
Parameters.

To clear DF1 data

1. Access the parameters in the WIM using a configuration tool.

2. Set the value of Parameter 09 - [Clear DF1 Counts] to “1 = Clear 
Counts,” and then press Enter to clear the DF1 data.

Ping in Message An unexpected ping was received.
Ping Time Flt A ping message was not received on DPI within the specified time.
Port Change Flt The DPI port changed.
Port ID Flt The WIM is not connected to a correct port on a DPI drive.
Type 0 Login The WIM has logged in for type 0 control.
Type 0 Time Flt The WIM has not received a type 0 status message within the 

specified time.

Event Description

Viewing and Clearing DF1 Communication Statistics 
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Notes:



Appendix A

Specifications 

Appendix A provides the specifications for the WIM.  

Topic Page Topic Page
Communications A-1 Environmental A-2
Electrical A-1 Regulatory Compliance A-2
Mechanical A-1

Communications

Radio
Transceiver

Frequency
Power
Range

National Semiconductor LMX9820A Bluetooth Serial Port 
Module, V1.1 Bluetooth Compliant Component

2.402 to 2.480 GHz Frequency Hopping
2.5mW Maximum RF Output
Class II – 10 m (32.8 ft.) anticipated* range

(*will vary due to environmental conditions)
Drive

Protocol
Data Rates

Drive Peripheral Interface (DPI)
125K/500K

Electrical 

Consumption 130mA at +12V DC

The serial converter draws the required power from the 
connected product. An external power source is not required.

Mechanical 

Dimensions
Height
Width
Depth

NEMA 1 WIM (20-WIM-N1) NEMA 4 WIM (20-WIM-N4S)
116.0 mm (4.57 in.) 180.0 mm (7.08 in.)
70.0 mm (2.75 in.) 93.0 mm (3.66 in.)
16.0 mm (0.63 in.) 25.0 mm (0.98 in.)

Weight 85g (3.0 oz.) 161g (5.7 oz.)
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NOTE: This is a product of category C2 according to IEC 61800-3. In a 
domestic environment this product may cause radio interference in 
which case supplementary mitigation measures may be required.

FCC Statement of Conditions

Compliance Statement (Part 15.19)

This device complies with Part 15 of the FCC rules. Operation is subject 
to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including 

interference that may cause undesired operation.

Environmental

Temperature
Operating
Storage

0 to +50° C (32 to 122° F)
-40 to +85° C (-40 to 185° F)

Relative Humidity 5 to 95% non-condensing
Atmosphere Important: The WIM must not be installed in an area where 

the ambient atmosphere contains volatile or corrosive gas, 
vapors or dust. If the WIM is not going to be installed for a 
period of time, it must be stored in an area where it will not be 
exposed to a corrosive atmosphere.

Vibration
Operating
Non-Operating

2.5G @5Hz-2KHz
5 G @5Hz-2KHz

Shock
Operating
Non-Operating

30 G peak acceleration, 11 (+/-1) ms pulse width
50 G peak acceleration, 11 (+/-1) ms pulse width

Regulatory Compliance 

Certification Specification
UL
cUL
CE
CTick
FCC ID
IC

UL508C
CAN / CSA C22.2 No. 14-M91
EN50178 and EN61800-3
AS / NZS 2064, Group 1, Class A
SNT-2XWIMNX
5450A-2XWIMNX



Specifications A-3
Warning (Part 15.21)

Changes or modifications not expressly approved by the party 
responsible for compliance could void the user’s authority to operate this 
equipment.

This device must not be co-located or operated in conjunction with any 
other antenna or transmitter.

RF Exposure (OET Bulletin 65)

To comply with FCC RF exposure requirements for mobile transmitting 
devices, this transmitter should only be used or installed at locations 
where there is at least 20 cm (7.9 inches) separation distance between the 
antenna and all persons.

Industry Canada Statement

The term “IC” before the certification/registration number only signifies 
that the Industry Canada technical specifications were met.
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Appendix B

WIM Parameters

Appendix B presents information about the WIM parameters.  

The parameters in the WIM are numbered consecutively. You can use the 
following configuration tools to access the parameters in the WIM.  

 

Topic Page
About Parameter Numbers B-1
Parameter List for DPI Products B-2
Parameter List for SCANport Products B-3

About Parameter Numbers

Configuration Tool Numbering Scheme
• Pocket DriveExplorer for Pocket PC
• DriveExplorer
• DriveExecutive
• HIM

The adapter parameters begin with parameter 
01. For example, Parameter 01 - [DPI Port] is 
parameter 01 as indicated by this manual.



B-2 WIM Parameters
Parameter List for DPI Products

No. Name and Description Details
01 [DPI Port]

Displays the port on the drive to which the WIM is 
connected.

Default: 0
Minimum: 0
Maximum: 7
Type: Read Only

02 [Comm Flt Action]
Sets the action that the WIM and drive will take if the 
WIM detects that wireless communications are 
disrupted. This setting is effective only if control I/O is 
transmitted through the WIM.

Default: 0 = Fault
Values: 0 = Fault

1 = Stop
2 = Zero Data
3 = Hold Last

Type: Read/Write
Reset Required: No

03 [Security Mode]
Enables/disables the security mode for the WIM, which 
prevents accessing its parameters and the connected 
drive for configuration.

Default: 0
Values: 0 = PIN Not Req’d

1 = PIN Required
Type: Read/Write
Reset Required: Yes

04 [Security PIN]
Sets the PIN number to access WIM parameters for 
configuration when Parameter 03 - [Security Mode] is 
set to 1 = PIN Required. See Page 3-23 for details.

Default: 0
Minimum: 0
Maximum: 9999
Type: Read/Write
Reset Required: Yes

05 [Reset Module]
No action if set to “Ready.” Resets the WIM if set to 
“Reset Module.” Restores the WIM to its factory default 
settings if set to “Set Defaults.” This parameter is a 
command. It will be set to “0 = Ready” after the 
command has been performed.

Default: 0 = Ready
Values: 0 = Ready

1 = Reset Module
2 = Set Defaults

Type: Read/Write
Reset Required: No

06 [Ref/Fdbk Size]
Displays the size of the Reference/Feedback. The drive 
determines the size of the Reference/Feedback. The 
WIM automatically uses the correct size.

Default: 0 = 16-bit
Value: 0 = 16-bit

1 = 32-bit
Type: Read Only

07 [Datalink Size]
Displays the size of each Datalink word. The drive 
determines the size of Datalinks.

Default: 0 = 16-bit
Values: 0 = 16-bit

1 = 32-bit
Type: Read Only

08 [DPI Data Rate]
Displays the data rate used by the DPI drive. This data 
rate is set in the drive, and the WIM autobauds to it.

Default: 0
Values: 0 = 125 kbps

1 = 500 kbps
Type: Read Only

!
ATTENTION: Risk of injury or equipment damage exists. Parameter 02 - 
[Comm Flt Action] lets you determine the action of the WIM and connected 
drive if communications are disrupted. By default, this parameter faults the 
drive. You can set this parameter so that the drive continues to run. 
Precautions should be taken to ensure that the setting of this parameter does 
not create a risk of injury or equipment damage. When commissioning the 
drive, verify that your system responds correctly to various situations (for 
example, loss of wireless communication).

!
ATTENTION: Risk of injury or equipment damage exists.The drive will fault 
when you remove or reset the WIM. Determine how the drive will respond 
before removing or resetting the WIM.
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09 [Clear DF1 Counts]
No action if set to “Ready.” Resets the DF1 statistical 
parameters 10 and 11 to 0 if set to “1 = Clear Counts.” 
This parameter is a command. It will be reset to 
“0 = Ready” after a “Clear Counts” command has been 
performed.

Default: 0 = Ready
Values: 0 = Ready

1 = Clear Counts
Type: Read/Write
Reset Required: No

10 [DF1 Packets Sent]
Displays the number of DF1 packets sent by the WIM. 
The value of this parameter is normally approximately 
equal to the value Parameter 11 - [DFI Packets Rcvd].

Default: 0
Minimum: 0
Maximum: 4294967295
Type: Read Only

11 [DF1 Packets Rcvd]
Displays the number of DF1 packets received by the 
WIM. The value of this parameter is normally 
approximately equal to the value Parameter 10 - [DFI 
Packets Sent].

Default: 0
Minimum: 0 
Maximum: 4294967295
Type: Read Only

No. Name and Description Details

Parameter List for SCANport Products

No. Name and Description Details
01 [Adapter Port]

Displays the port on the drive to which the WIM is 
connected.

Default: 0
Minimum: 0
Maximum: 7
Type: Read Only

02 [Security Mode]
Enables/disables the security mode for the WIM, which 
prevents accessing its parameters and the connected 
drive for configuration.

Default: 0
Values: 0 = PIN Not Req’d

1 = PIN Required
Type: Read/Write
Reset Required: Yes

03 [Security PIN]
Sets the PIN number to access WIM parameters for 
configuration when Parameter 03 - [Security Mode] is 
set to 1 = PIN Required. See Page 3-23 for details.

Default: 0
Minimum: 0
Maximum: 9999
Type: Read/Write
Reset Required: Yes

04 [Comm Flt Action]
Sets the action that the WIM and drive will take if the 
WIM detects that wireless communications are 
disrupted. This setting is effective only if control I/O is 
transmitted through the WIM.

Default: 0 = Fault
Values: 0 = Fault

1 = Stop
2 = Zero Data
3 = Hold Last

Type: Read/Write
Reset Required: No

!
ATTENTION: Risk of injury or equipment damage exists. Parameter 04 - 
[Comm Flt Action] lets you determine the action of the WIM and connected 
drive if communications are disrupted. By default, this parameter faults the 
drive. You can set this parameter so that the drive continues to run. 
Precautions should be taken to ensure that the setting of this parameter does 
not create a risk of injury or equipment damage. When commissioning the 
drive, verify that your system responds correctly to various situations (for 
example, loss of wireless communication).
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05 [Reset Adapter]
No action if set to “Ready.” Resets the WIM if set to 
“Reset Module.” Restores the WIM to its factory default 
settings if set to “Set Defaults.” This parameter is a 
command. It will be set to “0 = Ready” after the 
command has been performed.

Default: 0 = Ready
Values: 0 = Ready

1 = Reset Module
2 = Set Defaults

Type: Read/Write
Reset Required: No

06 [Clear DF1 Counts]
No action if set to “Ready.” Resets the DF1 statistical 
parameters 10 and 11 to 0 if set to “1 = Clear Counts.” 
This parameter is a command. It will be reset to 
“0 = Ready” after a “Clear Counts” command has been 
performed.

Default: 0 = Ready
Values: 0 = Ready

1 = Clear Counts
Type: Read/Write
Reset Required: No

07 [DF1 Packets Sent]
Displays the number of DF1 packets sent by the WIM. 
The value of this parameter is normally approximately 
equal to the value Parameter 11 - [DFI Packets Rcvd].

Default: 0
Minimum: 0
Maximum: 4294967295
Type: Read Only

08 [DF1 Packets Rcvd]
Displays the number of DF1 packets received by the 
WIM. The value of this parameter is normally 
approximately equal to the value Parameter 10 - [DFI 
Packets Sent].

Default: 0
Minimum: 0 
Maximum: 4294967295
Type: Read Only

No. Name and Description Details

!
ATTENTION: Risk of injury or equipment damage exists.The drive will fault 
when you remove or reset the WIM. Determine how the drive will respond 
before removing or resetting the WIM.
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A Application Code
Code that runs in the WIM after the boot code calls it. It performs the 
normal operations of the system.

B BCC (Block Check Character)

An error detection scheme where the 2’s complement of the 8-bit sum 
(modulo-256 arithmetic sum) of all data bytes in a transmission block. It 
provides a means of checking the accuracy of each message 
transmission.

Bluetooth Wireless Technology
Bluetooth wireless technology enables cable-free connection of devices 
that would normally be physically linked by wires, such as a drive 
connected to a computer.

Boot Code
Code that runs when the WIM first receives power. It checks basic 
operations and then calls the application code.

Bus Off
A bus off condition occurs when an abnormal rate of errors is detected on 
the Control Area Network (CAN) bus in a device. The bus-off device 
cannot receive or transmit messages. This condition is often caused by 
corruption of the network data signals due to noise or data rate mismatch.

C CAN (Controller Area Network)

A CAN is a serial bus protocol on which DPI is based.

CRC (Cyclic Redundancy Check)

An error detection scheme where all of the characters in a message are 
treated as a string of bits representing a binary number. This number is 
divided by a predetermined binary number (a polynomial) and the 
remainder is appended to the message as a CRC character. A similar 
operation occurs at the receiving end to prove transmission integrity.

D DF1 Protocol

A peer-to-peer link layer protocol that combines features of ANSI 
X3.28-1976 specification subcategories D1 (data transparency) and F1 
(two-way simultaneous transmission with embedded responses).



Glossary-2
DF1 Rate

A unit of signaling speed equal to the number of discrete conditions or 
signal events per second. It is also called “baud rate” or “serial port rate.”

DPI (Drive Peripheral Interface)

DPI is a second generation peripheral communication interface used by 
various Allen-Bradley drives and power products, such as PowerFlex 70 
and PowerFlex 700 drives. It is a functional enhancement to SCANport.

DPI Peripheral

A device that provides an interface between DPI and a network or user. 
Peripheral devices are also referred to as “adapters” or “modules.” The 
WIM and PowerFlex 7-Class HIMs (20-HIM-xxx) are examples of DPI 
peripherals.

DPI Product

A device that uses the DPI communications interface to communicate 
with one or more peripheral devices. For example, a motor drive such as 
a PowerFlex 7-Class drive is a DPI product. In this manual, a DPI 
product is also referred to as “drive” or “host.”

DriveExplorer Software

DriveExplorer software is a tool for monitoring and configuring 
Allen-Bradley products and adapters. It can be run on computers running 
Microsoft Windows 95, Windows 98, Windows ME, Windows NT 4.0 
SP6a, Windows 2000, Windows XP, and Windows CE (version 2.0 or 
higher) operating systems. DriveExplorer (version 3.xx or higher) can be 
used to configure the WIM and PowerFlex drives. Information about 
DriveExplorer and a free Lite version can be accessed at http://
www.ab.com/drives/driveexplorer.

DriveTools SP Software
A software suite designed for Microsoft Windows 98 Second Edition, 
Windows ME, Windows NT 4.0 SP6a, Windows 2000 SP3, and 
Windows XP operating systems. This software suite provides a family of 
tools, including DriveExecutive, that you can use to program, monitor, 
control, troubleshoot, and maintain Allen-Bradley products. DriveTools 
SP (version 1.01 or higher) can be used with PowerFlex drives. 
Information about DriveTools SP can be accessed at http://www.ab.com/
drives/drivetools.

E EDS (Electronic Data Sheet) Files

EDS files are simple text files that are used by network configuration 
tools such as RSNetWorx for DeviceNet to describe products so that you 
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can easily commission them on a network. EDS files describe a product 
device type, revision, and configurable parameters. EDS files for many 
Allen-Bradley products can be found at http://www.ab.com/networks/eds.

F Flash Update
The process of updating firmware in a device.

H HIM (Human Interface Module)

A device that can be used to configure and control a SCANport or DPI 
drive. PowerFlex 7-Class HIMs (20-HIM-xxx) can also be used to 
configure connected peripherals such as the WIM.

Hold Last

When communications are disrupted (for example, a cable is 
disconnected), the WIM and PowerFlex drive can respond by holding 
last. Hold last results in the drive receiving the last data received via the 
DF1 connection before the disruption. If the drive was running and using 
the Reference from the module, it will continue to run at the same 
Reference.

N NVS (Non-Volatile Storage)

NVS is the permanent memory of a device. Devices such as the WIM 
and drive store parameters and other information in NVS so that they are 
not lost when the device loses power. NVS is sometimes called 
“EEPROM.”

P PCCC (Programmable Controller Communications Command)
PCCC is the protocol used by some controllers to communicate with 
devices on a network. Some software products (for example, 
DriveExplorer and DriveTools SP) also use PCCC to communicate.

Ping
A ping is a message that is sent by a SCANport or DPI product to its 
peripheral devices. They use the ping to gather data about the product, 
including whether it can receive messages and whether they can log in 
for control.

Pocket DriveExplorer for Pocket PC Software

Pocket DriveExplorer for Pocket PC software is a Pocket PC tool for 
monitoring and configuring Allen-Bradley products and adapters. It can 
be run on a Pocket PC running Microsoft Windows Mobile 2003 (or 
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higher) operating system. Pocket DriveExplorer for Pocket PC (version 
1.xx or higher) can be used to configure the WIM and PowerFlex drives. 
Information about Pocket DriveExplorer for Pocket PC can be accessed 
at http://www.ab.com/drives/driveexplorer.

PowerFlex 7-Class Drives

The Allen-Bradley PowerFlex 7-Class family of AC drives includes the 
PowerFlex 70, PowerFlex 70EC, PowerFlex 700, PowerFlex 700VC, 
PowerFlex 700H, PowerFlex 700S, and PowerFlex 7000. These drives 
can be used for applications ranging from 0.37 kW (0.5 HP) to 3,000 kW 
(4,000 HP). All PowerFlex 7-Class drives support DPI, allowing them to 
use the WIM. This manual focuses on using the WIM with PowerFlex 
7-Class drives.

S SCANport

SCANport is a standard peripheral communication interface used by 
various Allen-Bradley drives and power products, such as 1305 and 1336 
PLUS II drives.

SCANport Peripheral

A device that provides an interface between SCANport and a network or 
user. Peripheral devices are also referred to as “modules” and “adapters.” 
The 1203-SSS serial converter and legacy drive HIMs (1201-H*) are 
examples of SCANport peripherals.

SCANport Product

A device that uses the SCANport communications interface to 
communicate with one or more peripheral devices. For example, a motor 
drive such as a 1336 PLUS II drive is a SCANport product.

Status Indicator

A status indicator is an LED that is used to report the status of a device. 
The WIM has one status indicator that emits blue, green, or red 
indications.

T Type 0/Type 1/Type 2 Control

When transmitting I/O, the adapter can use different types of messages 
for control. The Type 0, Type 1, and Type 2 events help Allen-Bradley 
personnel identify the type of messages that an adapter is using.

W WIM (Wireless Interface Module)

The WIM provides a wireless communications interface between any 
Allen-Bradley DPI drive and a computer or Pocket PC with an RS-232 
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port. The WIM uses a full-duplex DF1 protocol. The WIM may also be 
referred to as “20-WIM-N*,” “DPI peripheral,” or “module.”

Z Zero Data

When communications are disrupted (for example, a cable is 
disconnected), the module and drive can respond with zero data. Zero 
data results in the drive receiving zero as values for Logic Command, 
Reference, and Datalink data. If the drive was running and using the 
Reference from the module, it will stay running but at zero Reference.
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Notes:
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A
accessing parameters, 3-1

Adapter Port parameter (only for 
SCANport products), B-3

application code, G-1

attentions, 1-4

B
baud rate, see DF1 rate

BCC (Block Check Character), G-1

Bluetooth wireless technology, G-1

boot code, G-1

bus off, G-1

C
CAN (Controller Area Network), G-1

Clear DF1 Counts parameter
for DPI products, B-3
for SCANport products, B-4

clearing DF1 data, 4-5

clearing events, 4-5

Comm Flt Action parameter
for DPI products, B-2
for SCANport products, B-3

communications specifications, A-1

compatible products, 1-2

components, 1-1

configuration tools for parameters, 
3-1

CRC (Cyclic Redundancy Check), 
G-1

D
Datalink Size parameter (only for DPI 

products), B-2

DF1 Packets Rcvd parameter
for DPI products, B-3
for SCANport products, B-4

DF1 Packets Sent parameter
for DPI products, B-3
for SCANport products, B-4

DF1 protocol, G-1

DF1 rate, G-2

diagnostic items, 4-3

dimensions, A-1

DPI
definition, G-2
peripheral, G-2
products, 1-2, G-2

DPI Data Rate parameter (only for 
DPI products), B-2

DPI Port parameter (only for DPI 
products), B-2

DriveExecutive
using to establish wireless 

connection, 3-15
web site, see DriveTools SP

DriveExplorer
definition, G-2
free Lite version, G-2
using to establish wireless 

connection, 3-10, 3-15
web site, G-2

drives, see DPI products

DriveTools SP
definition, G-2
web site, G-2

E
EDS (Electronic Data Sheet) Files

definition, G-2
web site, G-2
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EEPROM, see Non-Volatile Storage 
(NVS)

equipment
required, 1-3
supplied, 1-3

event queue
clearing events, 4-5
list of events, 4-4
viewing events, 4-4

F
fault action, 3-22

fault queue, see event queue

firmware
parameters in, 3-1
release, P-2

Flash update, G-3

H
HIM (Human Interface Module), G-3

hold last
definition, G-3
setting, 3-22

I
installing the WIM

NEMA 1, 2-1
NEMA 4, 2-3

L
LED, see status indicator

M
manual

conventions, P-2
related documentation, P-1
web site, P-1

mechanical specifications, A-1

N
Non-Volatile Storage (NVS), G-3

P
parameters

accessing, 3-1
configuration tools for, 3-1
convention, P-2
list for DPI products, B-2–B-3
list for SCANport products, B-3–

B-4
numbering, B-1

PCCC, G-3

ping, G-3

Pocket DriveExplorer for Pocket PC
definition, G-3
using to establish wireless 

connection, 3-2
web site, G-3

power consumption, A-1

power cycle, 3-24

PowerFlex drives, G-4

products, see DPI products

Q
quick start, 1-5

R
radio

frequency, A-1
power, A-1
range, A-1
transceiver, A-1

Ref/Fdbk Size parameter (only for 
DPI products), B-2

regulatory compliance, A-2
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related documentation, P-1

removing the WIM, 2-5

Reset Adapter parameter (only for 
SCANport products), B-4

Reset Module parameter (only for DPI 
products), B-2

resetting the WIM, 3-24

RSLinx, P-1

S
safety precautions, 1-4

SCANport
compatible products, 1-2
definition, G-4
peripheral definition, G-4
product definition, G-4

Security Mode parameter
for DPI products, B-2
for SCANport products, B-3

Security PIN parameter
for DPI products, B-2
for SCANport products, B-3

serial port rate, see DF1 rate

specifications, A-1

status indicator
definition, G-4
operating status, 4-1
troubleshooting with, 4-1

T
technical support, P-3

tools, see equipment

troubleshooting, 4-1

U
update, see Flash update

V
viewing

DF1 data, 4-5
diagnostic items, 4-3

W
web site

DriveExplorer, G-2
DriveTools SP, G-2
Pocket DriveExplorer for Pocket 

PC, G-3
technical manuals/

documentation, P-1

WIM
accessing, 3-1
components, 1-1
diagnostic items, 4-3
event queue, 4-4
features, 1-2
illustration, 1-1
installing, 2-1, 2-3
parameters for DPI products, B-2–

B-3
parameters for SCANport 

products, B-3–B-4
removing, 2-5
resetting, 3-24

Z
zero data

definition, G-5
setting, 3-22
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